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I. Software Installation & Overview 
 

1. Introduction 
 

Ultratrend DMS is a data organizing software for creating and maintaining databases that apply to all 

the basic applications performed by the digital Ultraprobe models and 4Cast monitoring system. 

Users can select Generic, Bearings, Leaks, Valves, Steam and Electrical applications for inspection. It 

will store and organize records, provide reports, alarms, and charts. 

 

Users will be able to transmit data from Ultraprobe to a computer via USB, SD card, or Wi-Fi. 

 

The Ultratrend DMS software package supports internet communication with the 4Cast monitoring 

system. 4Cast is a unique system that continuously logs bearing data and bearing sounds. At pre-set 

intervals, all stored data and sound samples are sent to a computer for reporting and analysis. 

 

2. Program Overview 
 

To allow for customization and ease of use, the DMS 6 software is divided into three modules that 

can be installed separately or together based upon the end user’s configuration needs. These modules 

are the DMS Interface, DMS Database, and the UE 4Cast Controller.  
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DMS Interface 

 

The DMS Interface is similar in appearance and operation to Windows Explorer providing users with 

a “Record Hierarchy” view of the data and the ability to sort, organize and archive records. The 

record hierarchy is Plant, Application, Group, Location/Machine and Point. Each Record will 

maintain fields, which hold basic inspection data as well as a subsection for historical information. 

The hierarchy design of the program provides users with the capability of ever-expanding data 

management. 

 

The DMS Interface includes the 4Cast Manager, which is the configuration tool for interacting with 

4Cast devices. 

 

DMS Database 

 

The DMS Database is the storage location for all data that the system stores. A single database 

installation can have multiple interfaces and can support data acquisition from the 4Cast system even 

when the interface is not open. 

 

UE 4Cast Controller 

 

The UE 4Cast Controller is a module that allows for communication with the 4Cast and Ultraprobe 

15,000B. 

 

3. System Requirements 
 

 Windows 10 or 11 

 Windows Server 2016 or greater 

 Microsoft SQL Server 2016 or greater; Express 2017 is provided 

 5 GB of hard drive space minimum to install; 30 GB recommended for data storage 

 8 GB of RAM required; 16 GB of RAM recommended 

 Intel i5 or Ryzen 5 processor or greater 

 Microsoft Office 365 

 

4. Installing the Software 
 

The DMS 6 software can be downloaded from the UE Systems website: 

https://www.uesystems.com/product/dms/ 

 

To begin the installation, run the DMS Installer and select one of the following installation options. 

 

Easy Install: Full DMS System 
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The Full DMS System option is intended for a simple installation of the entire Ultratrend DMS 

software package on one computer.  

 

Easy Install: DMS User Interface Only 

 

 

 

The DMS User Interface Only option is intended for a simple installation of the DMS Interface on a 

client computer that will be accessing a previously installed database on another computer or server in 

their network.  

 

Custom Installation 

 

 

 

The Custom Installation option allows the user to choose what components of the DMS software to 

install. It also provides the option to install the DMS 6 database with a backup file, giving the new 

database access to previous data. Some users may choose an advanced configuration for the DMS 

installation using the existing SQL database instead of the SQL 2017 Express version included in the 

DMS software. If that is the case, the Custom Installation process can be used for those 

configurations. 

 

When the Custom Installation option is chosen, the 
user will then be given the option to select which 
components they would like to install.  

 
Each component that is selected will be highlighted 
“blue” and pressing the Next button will advance 
the installation process to the Database Instance 
Installation screen if the “Ultratrend DMS 
Database” module was selected. 
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From the Database Instance Installation screen 
of the DMS Custom Installer, the user can 
choose how the database table and instance 
will be installed. 

 

Database Instance Installation – The user can choose one of the following two options: “Use 

Existing Database Instance” or “Install SQL Server Express 2017”. If “Use Existing Database 

Instance” is chosen, they will need to use the Browse button to enter the location information for the 

database into the SQL Base Directory field provided. If “Install SQL Server Express 2017” is 

selected, the SQL Base Directory field should be left blank. 

 

Database Table Installation – The user can choose one of the following two options: “Create New 

Database” or “Import DMS Data Backup”. If “Create New Database” is selected, the user has chosen 

to create a blank database. If “Import DMS Data Backup” is chosen, they will need to use the Browse 

button to enter the location of the backup file in the field provided. 

 

After the user has made their selections, they can continue with the installation process by pressing 

Next at the bottom of the DMS Installer screen.  

 

5. Configuring the System 
 

During Installation 

 

 

When setting up the database during software 
installation, the user will be prompted with the 
screen. If creating a new database and not using 
an existing SQL Server Instance, then the default 
information can be used. 

 

 

The Database Connection Properties are as follows: 
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Authentication Mode – This refers to the way the server/DMS Interface will connect to the database. 

 

SQL Server Authentication – The account resides in the SQL server master database but nowhere on 

the Domain. 

 

Windows Authentication – The account resides in the Active Directory for the Domain. 

 

IP Address – The IP address of the computer that is running the database or Host Computer. If the 

database is on the same network as the server/DMS Interface being installed, the database computer’s 

local IP address or computer name would be used. If it is not on the same network, the external static 

IP would be used. 

 

To determine the IP Address of the Host Computer that is running the database, perform the 

following steps on that computer: 

 

a) Enter CMD in the search bar and select Command Prompt 

b) In the Command Prompt, type IPCONFIG and press enter 

c) Under IPCONFIG, look for the IPv4 address, this is the Host Computer IP Address that will be 

entered into the Remote Computer connecting to it 

 

Port – The port that SQL Server is configured to connect through on the database computer. 

Username – The username configured on the database computer for accessing the database when 

using SQL Authentication. The default username is UE_DMS_LOGIN 

Password - The username configured on the database computer for accessing the database when 

using SQL Authentication. The default password is Srr3Av5#a4ZTx7#s&eNU2L7kMTMnff 

 

The Server Connection Properties are as follows: 

 

Port – The port that the 4Cast Controller is listening for connection on. To properly connect, make 

sure this matches what is configured on the 4Cast boxes as well. 

 

Using the Connection Editor 

 

 

After installing the software, future database 
and server connection configuration changes 
can be made with the Ultratrend DMS 
Connection Editor. It can be found in the 
computer’s start menu programs in the UE 
System folder. It can also be found at the 
bottom of the Open Plant screen. 
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6. Basic Installation Configurations 
 

Local Computer – Single Point Access 

 

To install the DMS 6 software for use as a single point access on a local computer, please perform the 

following steps: 

 

1) Right-click the DMS Installer Application and select “Run as Administrator”. 

2) Select the Easy Install: Full DMS System option from the installation screen, when prompted 

select Next. 

3) Configure the Database Connection Properties and if unsure use defaults, when prompted select 

Next. 

4) Once installation is complete, restart the computer. 

 

Multiple Local Computers – On Same Network 

 

Local Server/Host Computer 

 

1) Determine IP Address or Computer name of Host Computer: 

a) Enter CMD in the search bar and select Command Prompt. 

b) In the Command Prompt, type IPCONFIG and press enter. 

c) Under IPCONFIG, look for the IPv4 address; this is the Host Computer IP Address that 

will be entered into the Remote Computer connecting to it. 

2) Right-click the DMS Installer Application and select “Run as Administrator”. 

3) Select the Easy Install: Full DMS System option from the installation screen, when prompted 

select Next. 

4) Configure the Database Connection Properties and if unsure use defaults, when prompted select 

Next. 

5) Once installation is complete, restart the computer. 

 

Local Client Computer 

 

1) Right-click the DMS Installer Application and select “Run as Administrator.” 

2) Select the Easy Install: DMS User Interface Only option from the installation screen, when 

prompted select Next. 

3) For the Database Connection Properties enter the IP Address or Computer name of the 

Server/Host Computer and if unsure all other options should be left at their default, when 

prompted select Next. 

4) Once installation is complete, restart the computer. 

 

Note: If DMS is installed for a different user, it is recommended that any additional users be given 

Full Control permissions for the following folders: 

 

- C:\Program Files\UE Systems 
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- C:\Program Files (x86)\UE Systems 

- C:\ProgramData\UE Systems 

- C:\ProgramData\UE Systems Backups 

 

7. Advanced Installation Configurations 
 

Use Cases 

 

 To use a different version of SQL Server than the default SQL Server 2022 Express. 

 The user is not concerned with where the database files live in the file system. 

 

Additional Requirements 

 

1) SQL Server 2017 or greater 

2) Windows Server 2016 or greater 

3) A database instance with FILESTREAM enabled 

 

Manual SQL Server Installation 

 

 

Install SQL Server 
Run setup.exe 
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- Go to the Installation section. 
 
- Click first option “New SQL Server 
stand-alone installation or add features to 
an existing 
Installation.” 

 

 

 

- After a few moments, a new window will 
open: 
 
- Click Next 

 

The installer will automatically progress 
through Install Setup Files and into Install 
Rules.  

- Click Next. 

Note:  

You will have one warning for Windows 
Firewall. This is a warning to make sure that 
you open firewall ports, as necessary. This 
can be done later. 
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- Free customers can use the Express option, 

while paid customers should enter their 

product key.  

- Click Next. 

 

 

- Check the box to accept the license 
agreement 

- Click Next  

 
 

 

- Select Database Engine Services and SQL 

Server Replication (red). All other items can 

remain unchecked, but you may install them 

if you choose. For the Instance Root 

Directory (green), we set this value to 

“C:\Program Files\UE Systems\UE 

Database\SQL Server\” in our installer, but 

any directory is valid.  

- Press Next to continue. If only the above 

options were selected, then the installer will 

skip through Feature Rules into Instance 

Configuration. 
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- The installer sets the instance name/id to 

“UE_DATABASE” but, may use any 

instance name that is not already listed 

under Installed Instances.  

- Setting the Name will, by default, set the 

Instance ID to the same value.  

- Press Next  

 
 

 

- The installer will prefill the account names with 
default values. 
These can be left untouched. 
 
- Click Next 

 

- Select the type of authentication mode 

(Windows or Mixed). Most users will 

typically use the latter option.  
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- If Mixed is selected, a default password 

should be set for the “sa” account (red). This 

is the super-administrator account that is 

given unlimited permissions to the database, 

so this password should be secure.  

 

- We also typically add the 

BUILTIN\Administrators group to the list of 

administrators. 

 

 

- To add additional admins, select the 
Add… button (green) and enter the 
user/group name. For example, to add all 
admins, enter “Administrators” in the 
“Enter the object names to select” box 
- Press Check Names. 
The text will be replaced with 
“ComputerName”\Administrators. 

- Press OK to add the user to the list. If 
you do not want all admins to have 
access, then selectively choose users to 
add. Non-Windows users can be added 
later.  
 

 

 

 

- In Data Directories tab, leave everything 
automatically filled. 
 
- Click Next 
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- In TempDB tab, leave things as default 
as well. 

 
 

 
 

 

- Within the FILESTREAM tab, check all the 
boxes to enable FILESTREAM access and keep 
the share name the same as the instance name 
(which will be defaulted). 

- Press Next  
 

 

- This page will summarize all items you 

are about to install and show you the path 

to a configuration file that includes all the 

configuration the installer will use. 

- Press Install to start the installation. It 
may take a few minutes to complete. At the 
end, the user should get the following 
success screen: 
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- SQL Server is installed, but it does not know 

what the database is.  

- Click Close 

- Run the DMS installer with a custom 

configuration to finish installation. 

 

 

DMS Custom Install 
 

- Open the DMS Installer, select Custom 
Installation. 

 

- Press Next 

 
 

 

- Select what features to install, but at a minimum, 
select “Ultratrend DMS Database”  
 
- Press Next  
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- Select “Use Existing Database 

Instance” for Database Instance 

Installation and leave Database Table 

Installation set to “Create New 

Database.” 

- Click Next 

 

 
 

 

- Set the Server Instance to the same value used when 

installing SQL Server. Then configure the username and 

password of the UE_DMS_LOGIN user. Default values 

are used here, but you can change them. However, if you 

do change them, make sure the same credentials are used 

on other installations. 

- Alternatively, if you would like to use Windows 

Authentication, switch to that authentication mode, and 

ignore the username and password fields. 

 

  - Press Next 

 

- The installer will check for existing 

installations of the DMS software. This may 

take a few minutes. 
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- The installer will display the items to be 
installed and those that are already installed. 

- Press Next to proceed with installation.  

- This will take several minutes and proceed 

to the Installation is Complete screen: 

 

 

- Press Exit to complete setup. 
 

 
 

8. Uninstalling the Software 
 

The DMS Uninstaller can assist with the removal of the different modules and components of the 

DMS 6 software by selecting Ultratrend DMS 6 (Full) from the computer’s Add and Remove 

Programs list. 

 

Using the DMS Uninstaller 

 

 

When Ultratrend DMS 6 (Full) is selected to be 
uninstalled from the computer’s Add and Remove 
Programs list, the DMS Uninstaller application will 
open. From here, select which portions of the DMS 6 
software to uninstall. The option to save a backup file 
can also be selected from the DMS Uninstaller screen. 
The backup file can be used during a new installation to 
provide access to the old data. 
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The uninstall process will begin when the user presses the button labeled Next. If the checkbox for 

“Backup database before uninstalling?” is left blank, then the user will receive two warnings 

confirming they understand that their database will be deleted if they continue. After all portions of 

the DMS 6 software have been uninstalled, the user will need to restart their computer to complete the 

process. 

 

Creating a Backup File 

 

If the user needs to uninstall the DMS 6 software completely from their computer and wants to keep 

all the data in their current database so it can be used with a new installation of the software; they will 

need to create a backup file from the DMS Uninstaller. To create a backup file during the 

uninstallation process, the user will need to enter a check in the box next to “Backup database before 

uninstalling?” of the DMS Uninstaller screen. They will also need to use the “Browse” button to 

determine the location of where the backup file will be saved.  

 

The backup file saved will be a .bak only file that can only be used when the user is performing a new 

installation of the DMS 6 database. The .bak file is a single file that includes all the information for 

every Plant that was in the DMS database at the time of the uninstallation. It is NOT the same as the 

“Save a Copy of Plant” or “Export Database” functions in DMS; it can only be used when installing 

the DMS database. 

 

9. Ultratrend DMS 4 – 5 Exporter 
 

The DMS 4 - 5 Exporter is a separate application included with the 
installation of the DMS 6 software. It can be accessed from the UE 
Systems folder of the computer’s Apps or Programs list in the 
Windows Start menu. This application can be used to export data from 
a DMS 5 database and converted, so it can be imported into a DMS 6 
database.  

 

 

Note: DMS 5 is in a Microsoft Access database format and DMS 6 is in a Microsoft SQL database 

format.  

 

Using the Exporter 

 

Once the DMS 4 -5 Exporter has been opened, perform 
the following steps to convert and export DMS 5 Plant 
folders that can be imported into a DMS 6 database: 

 

 

1) Create a new folder on the computer where the converted Plant folder from DMS 5 will be saved. 

It is advised that the folder name be the same as the original plant from DMS 5 to mitigate any 

confusion that could occur during the DMS 6 importing process.  
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2) Plants Path – This field is used to identify the DMS 5 Plant folder that needs to be exported. It 

defaults to the “DMS Plants” folder location but can be changed by selecting the browse folder on 

the right. If the “DMS Plants” folder is left selected it will export all the Plant folders located 

within it together. If the user has a significantly large database, it is recommended they select one 

Plant at a time to avoid a potentially lengthy conversion process. 

3) Output Path – This field is used to identify the folder where the converted DMS 5 data will be 

saved. Use the bottom browse folder to the right of the Output Path field to locate the folder 

created in the first step. Once selected, the file path should be displayed in this field. 

4) Export Plant(s) – When the user has chosen both paths, they can press the “Export Plant(s)” 

button to begin the exporting and converting process. There will be a progress bar showing how 

far the conversion process is from completion. Once completed the DMS 4 - 5 Data Exporter will 

disappear. 

5) To import the converted Plant folders from DMS 5 into the DMS 6 database; please reference the 

“II. Basic Operation: 11.4. Import / Export Database” section of this manual for more information 

on importing and exporting databases. 

 

10. Ultratrend DMS Backup Schedule 
 

The DMS Backup Schedule provides the user with the ability to create database backups based upon 

a set schedule defined by that user. The user will be able create a one-time backup or set a schedule 

for that backup based upon days, weeks, or months. 

 

Once configured, the backups will continue to be created without user notification based upon the 

previously defined schedule until that user selects a new schedule or generates a one-time backup. 

The backups will be stored in a default folder created by DMS 6 unless the user selects a new folder 

path when creating the backup. The Backup Schedule is only located on the computer that has the 

Database. 

 

Scheduling the Backup 

 

 

Open the start menu and select the UE Systems folder. The 
“Ultratrend DMS Backup Schedule” can be selected and 
opened from within this folder. The DMS Backup Schedule 
Screen will allow the user to schedule and create backup files 
of their DMS 6 database. 
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Creating a One-Time Backup 
 

1) Select “One Time”. 
2) Select where the backup file will be saved. 
3) Click OK when finished. Backup will be 

created 1 minute after selecting OK. 
 

This option will only create one backup file. 
 

 

 

Creating Daily Backups 
 
1) Select Daily, choose the start date and time of when 

the backups will occur. 
2) Choose how often the backups will be created for 

“Recur every __ days.” 
3) Select the number of backups to store and where the 

backup file will be saved. 
4) Click OK when finished. 

 

Creating Weekly Backups 
 

1) Select Weekly, choose the start date and time of when 
the backups will occur. 

2) Choose how often the backups will be created for 
“Recur every __ days.” 

3) Select the days for the backups to occur. 
4) Select the number of backups to store and where the 

backup file will be saved. 
5) Click OK when finished. 

 

 

 

Creating Monthly Backups 
 
1) Select Monthly, choose the start date and time of 

when the backups will occur. 
2) Select the months for the backups to occur. 
3) Choose which day the backup will be created for that 

month(s). 
4) Select the number of backups to store and where the 

backup file will be saved. 
5) Click OK when finished. 

 
Changing the Backup Location 
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1) Select the browse folder. 
2) Choose the new folder location. 
3) Verify that the new file location selected is 

displayed in the Backup Directory field. 
4) Select OK 

 
 

Advanced Settings 

 

 

Press the “Advanced” button in the bottom right corner 
of the DMS Backup Schedule window to open the 
Advanced Settings Screen. 
 
This menu displays the path and directory of the 
PowerShell and script, along with the Server Name and 
Instance. 

 

Note: This screen should not be changed unless special setting(s) is required by the current server or 

computer where the DMS database is installed. 

 

11. DMS Admin Interface 
 

Overview 

 

By default, DMS allows open access to all data in all plants. If an administrator would prefer to limit 

the plants users are able to access, they may use the DMS Administration Interface to do so. 

 

DMS supports two types of user authentication: built-in, where users and passwords are specified 

within the interface and permissions are assigned explicitly, and OpenID Connect integration, where 

user and plant information are received from an external server. 

 

To access the DMS Admin Interface, the user needs to have permission to edit the `config_privileged` 

table in the database. This is granted to any user who is part of the `UE_DMS_PRIVILEGED_USER` 

database role. Windows administrators are automatically included in this role if Windows 

Authentication is in use. Use the DMS Connection Editor to change the credentials with which you 

access the Admin Interface. 
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Upon launching the DMS Admin Interface, the UI 

to the right is presented. 

 

The red-highlighted checkbox is used to enable 

the authentication system. The blue-highlighted 

dropdown is used to change the language for the 

interface. 

 

Upon checking the `Enable Access Control and 

Permissions` checkbox, the UI enables a few extra 

fields. 

 

The red-highlighted checkbox is used to enable the 

Built-In Authentication system, which allows for 

creating and users with direct plant permissions 

entirely within DMS. The blue-highlighted +/- 

buttons are used to add/remove OpenID-Connect 

(OIDC) endpoints.  

 

The green list box contains an entry for each 

authentication option: `DMS` will be listed at the 

top for built-in authentication, if enabled, while a 

user-entered name will be displayed for each 

OIDC option. 

 

Built-In Authentication 

 

With built-in authentication, users are created explicitly with individual passwords. Users have the 

option to be set as “Admin”. If they are “Admin”, they will have the ability to access all plants in the 

database without being given individual plant permissions. Otherwise, users will only have access to 

plants they are explicitly given access permissions for. 

 

Configure Password Requirements 

 

While not presently exposed in DMS, a future 

update will enable users to modify their own 

passwords.  

Once that feature is available, these parameters will 

determine the complexity requirements for 

passwords.  

These requirements are not imposed when 

passwords are set from the Administration Interface 

directly. 
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Configure Users 

 

By selecting “Users” or “Probes” a list will be shown 

for all users or probes that have been created.  

The “Update User” button is used to modify the 

password or “admin” status of a selected user.  

The +/- buttons are used to add or delete a user. 

When updating a user, the “Username” field is not 

editable. 

 

Creating New User 

 

Select the “+” button to create a new user. Enter the “Username”, 

“Password”, and checkmark “Admin” (if access to all plants is 

needed). 

 

 

Configure Plant Permissions for Users 

 

 

After creating a user, they will not immediately have 

access to any plants. To grant access to plants, select 

the user’s name on the left, and then select the 

checkboxes next to each plant the user should have 

access to on the right. 

 

 

 

OpenID Connect Authentication 

 

OpenID Connect authentication delegates users and permissions to an Identity Provider service.  

 

Create the OpenID Connect Authentication Option 
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Select the “+” at the bottom left of the Interface.  

 

Note: If the OIDC option should be removed, select it, and use the 

“-” button at the bottom left of the Interface. 

 

Configure the OpenID Connect Authentication Option 

 

The OIDC authentication option only needs to 

know how to connect to the OIDC provider.  

Note that there is a special case of OIDC and 

Built-In authorization working in combination, 

where user authentication (login) is handled by 

OIDC, but permissions are managed by the Built-

In Authorization. To facilitate this, the “sub” 

claim returned by OIDC must match the 

“username” in built-in authentication. 

 

 
OpenID Connect 
Field 

Description 

Identity Provider / 
Authority URI 

This is the URI at which the OIDC provider can be queried. To confirm that the URI is 
correct, ensure that if “well-known/OpenID-configuration” is appended to it, a JSON 
document describing the open-id configuration is returned. 

Return URI This is the URI DMS will send to the Authority URI when authenticating. DMS does not 
have a return server, but many providers require this field to be used for security purposes. 

Client ID This field is optional, but may be used by the provider as an identifier to limit the claims 
that will be sent to DMS 

Client Secret This field is option, but standard in OIDC connections 

Scopes This field is a space-separated list of which claims should be requested when DMS 
authenticates. The standard “openid” scope will always be included in the request and does 
not need to be included here. 

Authorization Mode If set to “Use OIDC Claims”, then the Plants and Admin permissions will need to be 
specified by the OIDC server. If set to “Use Built-In Authorization”, then the “sub” claim 
will need to match existing users in the Built-In Authentication section. 

Claim Name: Plants This claim name identifies the claim(s) that will include the Authentication ID(s) for the 
user’s allowed plants.  
Allowable formats for the value of this claim in the OIDC response are: 

1) JSON Array of strings, where each string element is an Authentication ID 
2) Comma-separated list of Authentication IDs 
3) Single Authentication ID (containing no spaces) 

Multiples of these claims are allowed, if the Identify Provider allows this. 

Claim Name: Admin This claim name identifies the claim name that will include a boolean (true/false, 1/0, 
yes/no, y/n, t/f) value indicating if the user should have access to all plants. 
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DMS Configuration to Link to OpenID Connect 

 

OpenID Connect authentication returns a list of “Authentication IDs” to 

decide which plant a user should have access to. These IDs are 

compared to the “Authentication ID” specified when a plant is created. 

 

12. Silent Installation Guide 
 

Installation Notes 

 

Silent installation will use the same default parameters as the UI version of the installer users, so 

command-line options are more like overrides than requirements. 

 

Installation often requires restarting the computer. The silent installer will not do this automatically, 

so machines should be restarted either by the user or by a script after installation. 

 

Installation Arguments 

 

The installer supports silent installation via supplied command-line parameters if the “-quiet” 

argument is set. These parameters are passed according to the format:  

'DMS Installer.exe' -quiet -paramName1 value1 -paramName2 value2 … 

Parameter names are not case-sensitive, and parameter values are not case-sensitive for parameters 

with fixed values. Any value can be omitted to use default values 

 
Parameter Name Parameter Value Action 

Mode 

ui Installs the DMS User Interface and related dependencies 

server Installs the 4Cast Controller Service 

database Installs the SQL Server database, tables, and users 

admin Installs the Admin Interface 

normal 
Installs the DMS User Interface, 4Cast Controller 
Service, and SQL Server Database 

full 
Installs the DMS User Interface, 4Cast Controller 
Service, SQL Server Database, and Admin Interface 

(comma-separated list 
without spaces) 

Installs all selected modules. Example: 

'DMS Installer.exe' -mode ui,database  

would install the DMS UI and the database 

DatabaseInstallMode 

install 
Installs SQL Server, if not already installed, with the 
instance name specified by DatabaseConnServer on the 
local machine (ignores DatabaseConnIP) 

existing 
Connects to the existing SQL Server instance at 
DatabaseConnIP:DatabaseConnPort (if remote) or 
named DatabaseConnServer, if local 

DatabaseInstallPath  
Specifies the directory to which the database should be 
installed if DatabaseMode is “install” 

DatabaseImportPath  
Specifies the location of the .bak file that should be 
imported into the database instance before being 
upgraded to the current database version 
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Parameter Name Parameter Value Action 

DatabaseConnMode 

windows Configures Windows Authentication only 

SQL 

Configures Windows Authentication and SQL Server 
username/password authentication. Creates the user 
specified by DatabaseConnUser with password 
DatabaseConnPassword. 

DatabaseConnUser (SQL Username) 
Sets the name for the user for SQL Database (when 
DatabaseConnMode is “SQL”) 

DatabaseConnPassword (SQL Password) 
Sets the password for SQL Database user 
DatabaseConnUser (when DatabaseConnMode is 
“SQL”) 

DatabaseConnIP (SQL Network Address) 
Sets the IP or computer name of the machine running the 
database. Ignored if installing the database 
DatabaseMode is “install” 

DatabaseConnPort (SQL  Server Port) 
Sets the TCP Port exposed on the machine running the 
database.  

DatabaseConnServer (SQL Instance Name) 

Sets the name of the instance to be installed if 
DatabaseConnMode is “install” or to be referenced if 
DatabaseConnMode is “existing” and DatabaseConnIP 
is “.” 

ServerConnPort 
(4Cast Controller 
Service Port) 

Sets the port to be opened for the 4Cast Controller 
Service is the “server” is being installed 

 

Installation Examples 

 

To run a normal installation with default options (a “simple” installation): 

'DMS Installer.exe' -quiet 

To run a normal installation with default options (a “simple” installation) using PowerShell. Note the 

use of the loop to await completion (theoretically, the -Wait flag would have the same effect, but this 

fails at the time of this writing): 

$install = Start-Process '.\DMS Installer.exe' -ArgumentList '-quiet' -PassThru 

while (-not ($install.HasExited)) { Start-Sleep -Seconds 5 } 

To install the DMS UI targeting a remote database with Windows Authentication: 

'DMS Installer.exe' -quiet -mode ui -DatabaseConnMode windows -DatabaseConnIP 10.11.12.13 

To install the Database only with SQL Server Authentication at the default location: 

'DMS Installer.exe' -quiet -mode database -DatabaseConnMode sql -DatabaseConnUser my_user -

DatabaseConnPassword my_password 

 

Uninstallation Notes 

 

The uninstaller is located at: 

%ProgramFiles%\UE Systems\Uninstaller\DMS Uninstaller.exe 

Uninstallation often requires restarting the computer. The silent uninstaller will not do this 

automatically, so machines should be restarted by either the user or by a script after uninstalling. 
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The uninstaller removes modules individually with a best-effort approach to cleanup when doing so. 

If all modules are removed, then the uninstaller deletes all directories. Note that some dependencies 

may be used by other applications (such as LabVIEW and VISA Runtimes), and DMS cannot detect 

if that is the case, so while they may be installed for DMS, they will not be uninstalled. If no other 

applications are using these runtimes, they may be uninstalled separately. 

 

Uninstallation Arguments 

 

The uninstaller supports silent installation via supplied command-line parameters if the “-quiet” 

argument is set. These parameters are passed according to the format:  

'DMS Uninstaller.exe' -quiet -paramName1 value1 -paramName2 value2 … 

Parameter names are not case-sensitive, and parameter values are not case-sensitive for parameters 

with fixed values.  

 
Parameter Name Parameter Value Action 

Mode 

ui Uninstalls the DMS User Interface 

ui_driver Uninstalls the CP210x driver required for DMS 

server Uninstalls the 4Cast Controller Service 

database_tables Uninstalls the database tables, while retaining the instance 

database_instance Uninstalls the database instance entirely 

admin Uninstalls the Admin Interface 

full Uninstalls everything 

(comma-separated list without 
spaces) 

Uninstalls all selected modules. Example: 

'DMS Uninstaller.exe' -mode ui,ui_driver,server`  

would install the DMS UI, drivers, and the 4Cast 
Controller Service 

BackupPath  
File path of the .bak file to be created before uninstalling 
the database. Omit to skip backup. 

 

Uninstallation Examples 

 

To uninstall everything: 

'DMS Uninstaller.exe' -quiet 

To uninstall everything using Powershell: 

Start-Process 'DMS Uninstaller.exe' -Wait -ArgumentList '-quiet' 

To uninstall the DMS UI only: 

'DMS Uninstaller.exe' -quiet -mode ui,ui_driver 

 

II. Basic Operations 
 

13. File Menu 
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This menu provides numerous basic functions centered around 
the management and sharing of Plant folders; the foundation of 
the DMS database. 

 
 

Open Plant 

 

 

When choosing the Open Plant option from the File menu, the user will be 
provided with a list of previously created Plants. By selecting one of these 
Plants the DMS program will populate with the hierarchy and information 
pertaining to that Plant. The user may have multiple Plants open at one 
time that can be navigated by using the DMS database hierarchy. 
 
For databases with a large list of Plants, the active search filter is available 
at the top of the Open DMS Plant screen to help users find their desired 
plant from the list. 

 

New Plant 

 

The fundamental starting point for creating a new database in the DMS 6 software is by first creating 

a New Plant. When the New Plant option from the File menu is selected, the user will be prompted to 

enter a name for that plant. This will also be the name of the Plant folder that will be created to house 

all information added to that Plant in the future. 

 
Import / Export Database 

 

 

Allows the user to import Plants from other locations to be 
incorporated within their own database and/or be able to export 
their own Plants to be saved as a backup or be imported 
somewhere else. Users are also able to export and import their 
4Cast configurations. 

 

Data Transfer Options 

 

DMS Data Export – This option allows the user to export a Plant folder from their database. The 

exported copy will be identical to the original Plant and can be used as a backup if needed. All the 

data, images, and sound files will be included in the export. 

 

DMS Data Import – Users can import Plant folders from other databases to their DMS database by 

selecting this option. The new Plant will be available in the “Open a DMS Plant” List with the other 

existing Plants in the database. All the data, images, and sound files will be included in the import. 
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4Cast Config Export – This option allows the user to export their 4Cast configuration settings found 

in the 4Cast Manager. 

 

4Cast Config Import - Users will be able to import 4Cast configuration settings into their 4Cast 

Manager with this option. 

 

To Import / Export Data and Configuration settings; perform the following steps: 

 

1) Select the Data Transfer Option. 

2) In the Folder field, navigate to the folder location where the data will be sent to or received 

from, based upon the Data Transfer Option selected, and press the “Current Folder” button. 

3) Enter a check mark in the box next to each Plant listed for the data to be transferred. 

4) Press the Import / Export button to complete the process. 

 

Note: For larger databases, it is recommended that the user import or export them individually to 

reduce the amount of time needed for the conversion process and to mitigate the potential for data 

transfer interruption. 

 

Login / Logout 

 

When the access control and permissions have been enabled through the DMS Administration 

Interface the Login / Logout options will be utilized.  

 

Exit Program 

 

This will close the DMS program for the end-user. 

 

Note: If Plant folders were left open when a user exits the DMS program they may become Locked 

Plants for other users. 

 

14. Edit Menu 
 

This is where the database search feature and general user 
Preferences can be found. Including a check for updates 
option and the Spectralyzer file path location. 
 

 
 

Database Search using Find 

 

 

The Find feature provides users with the ability to search 
their database for any Hierarchy Item and automatically open 
it when it is selected from the list. 
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Note: If the “Search All Plants” box is unchecked it will only find what is entered into the search 

field from the Plants currently open in the Hierarchy window. 

 

Edit Preferences: General Tab 

 

 

Languages - Select from a list of languages, restart the DMS 
Program to implement the change. 

 
Units: Standard or Metric measurements 

 
Currency - US dollars, British Pound, or Euros 

 
Check for Updates - When checked the program will notify 
the user of any new updates that are available to be 
downloaded from the UE Systems Website. 

 

Edit Preferences: Path Tab 

 

 

Spectralyzer Path - If the UE Spectralyzer program is 
installed on the same computer as the DMS 6 program, it will 
list the path to the Spectralyzer executable file. 

 

Note: The Spectralyzer Path defaults to: (C:\Program Files\UE Spectralyzer\UE Spectralyzer.exe) 

and should never be modified or changed. 

 

15. Communications Menu 
 

This menu is used by the DMS database to manage connections 
with Ultraprobe equipment to allow for the downloading and 
uploading of data to the DMS database.  
 
For single group mode, data will be uploaded from the Group 
position of the DMS hierarchy to Ultraprobe 401, 9000, 10,000 
and 15,000. The data collected from Ultraprobe 401, 3000, 9000, 
10,000 and 15,000 will then be downloaded back into the selected 
Group to be stored. 

 

 

For multi-group mode using the Ultraprobe 15,000B, data will be uploaded and downloaded using the 

“Select Groups for Sync” and “Synchronize Groups on Probe” options. When configuring the probe 

for this, the UP15000B probe configuration will need to be selected. 
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For single-group mode using the Ultraprobe 15,000B, data will be uploaded and downloaded using 

“Send Group to Probe” and “Retrieve Group from Probe” options by right-clicking the Group name 

in the DMS Hierarchy. When configuring the probe for this, the UP15000 probe configuration will 

need to be selected. 

 

Configure Probes 

 

 

 Each Ultraprobe model is different and therefore DMS must be 
configured to the specific Ultraprobe being used for data 
transfer. Selecting Configure Probes opens the “Probe Manager” 
window which will display a list of Ultraprobe instruments that 
have been previously set up and available. From this window the 
user can test, remove, and change the settings of an existing 
probe or create a new configuration. 

 

To add a new configuration for your Ultraprobe, click on the New button located at the bottom of the 

“Probe Manager” window to open the “New Ultraprobe Wizard.”  

 

 

There are two methods of establishing a new connection 
between an Ultraprobe and the DMS 6 database: Automatic 
Probe Detection and Manual Setup.  

 

Automatic Probe Detection 

 

When selecting this option for probe detection, first ensure that the Ultraprobe is connected to the 

computer. If using an Ultraprobe 3000 or 9000 model, this will be done by direct connection with the 

computer. If using an Ultraprobe 401, 10,000, 15,000 or 15,000B; that connection is made by 

inserting a SD card into the computer. DMS will search for the Ultraprobe and populate a list with 

available selections that were detected based upon the connection method that was used to identify 

the Ultraprobe. Select the correct Ultraprobe from the list to register it for future connections with the 

DMS software.  

 

Note: Always try using Automatic Probe Detection first before attempting a Manual Setup. 

 

Manual Probe Setup 

 

If utilizing this option, all the required information to configure the connection between the 

Ultraprobe and the DMS 6 database can be manually entered.  
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To manually setup the probe, perform the following steps: 

1) Choose the desired probe from the dropdown list provided. 

2) Press the Settings button; enter the requested configuration 

information needed to make the connection and press OK. 

3) Press Next and then Finish to test and complete the connection. 

 
 

Selected Probe 

 

This lets the user know which probe has been selected for communication with DMS. If multiple 

Ultraprobes are being used, it is recommended to routinely check this before uploading and 

downloading data. 

 

Administer Probes 

 

 
When “Access Controls and Permissions” are 
enabled in the DMS Admin Interface, the 
Administer Probes option under the Communication 
Menu can be used to assign what Plants are 
accessible for an Ultraprobe 15,000B using multi-
group mode.  
 
If the DMS Admin Interface is not being used or the 
DMS user does not have “Admin” permissions 
assigned to them in the Admin Interface, then this 
option will be greyed out.  

 

 

Add / Remove Probe 

 

 

Select the “+/-” button to add or remove a probe.  
 
To add a probe, enter the Probe ID, Probe Name, and All Plants (if 
access to all plants is needed). 

 

Note: The Probe ID for Ultraprobe 15,000B can be found in the Info/Software Versions screen on the 

instrument or in the “hw.id.dms” text file on the SD card. 
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Update Probe 

 

The “Update Probe” button is used to modify an existing probe.  
 
When updating a probe, the “Username” field is not editable. 

 
 

Granting Plant Access for Probes 

 

 

After a probe has been added, it will not immediately have 
access to any plants.  
 
To grant access to plants, select the probe’s name on the 
left, and then select the checkboxes next to each plant that 
the probe should have access to on the right. 

 

Alternatively, the “Authentication ID” field can be used to identify and assign to the probe any 

Plants that have the corresponding ID. 

 

Select Groups for Sync 

 

 

When using an Ultraprobe 15,000B in multi-group mode, 
users can select which Groups to send to their SD card. 
This will include all the Group Hierarchy and Baseline 
information needed for data collection. New data collected 
can then be uploaded quickly to DMS through syncing with 
WiFi directly from the Ultraprobe or with the SD card 
using the “Synchronize Group on Probe” option. 
 
To select all the Groups in a specific Plant or Application, 
right-click the name and choose Select All from the menu 
options. 

 

Note: If the DMS Admin Interface is enabled, the SD card must be initialized on first use by placing 

the card into the UP15,000B and turning it on briefly so it can create the Probe ID file on the card 

that will be needed to identify it in the Admin Interface. 

 

Synchronize Group on Probe 
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When using an Ultraprobe 15,000B in multi-group mode, all data collected on the SD card can be 

synchronized between the DMS database and the Ultraprobe for any groups that were previously sent 

to the SD card.  

 

Note: If the DMS Admin Interface is enabled, the SD card must be initialized on first use by placing 

the card into the UP15,000B and turning it on briefly so it can create the Probe ID file on the card 

that will be needed to identify it in the Admin Interface. 

 

Test Connection 

 

After an Ultraprobe has been connected to the computer, make sure the data transfer will be 

successful. Use Test Connection to be sure the SD or USB connection is working. 

 

Clear Instrument 

 

This will delete data only from the Ultraprobe 3000 & 9000 models. The instrument must be 

connected and in setup mode for the data to be cleared. 

 

Note: To delete the old data from the SD card, the user will need to go into the SD card and manually 

delete all the files and folders. Another option is to reformat the SD card to ensure all the old data is 

removed. 

 

16. Notifications Menu 
 

This feature can be used by the user to establish alerts based 
upon notification criteria to be sent to the user by email, text 
or webhooks. These alerts can be triggered whenever the data 
is downloaded to DMS. For the user to receive a notification, a 
Point in the DMS hierarchy must meet or exceed the 
notification criteria they have established for a Plant that the 
user has chosen to monitor. 
 

 

Edit Notifications: Email Settings Tab 

 

 

From this tab on the Edit Notifications window, the 
end-user will be able to enter the appropriate access 
information for the email address that will send the 
notification from the “host” mail server.  
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Host – The email server outgoing mail service. (Example: Gmail host outgoing server is 

smtp.gmail.com). 

 

Port – This is the port number that the outgoing email service uses. This information can often be 

found for most free email providers through the computer’s web browser. If the user is unable to find 

this information, they may need to contact their IT department for assistance, (Example: The Gmail 

outgoing server uses port 465 and/or port 587.) 

 

SSL Enabled – When enabled, it increases the security of the connection by encrypting the email. 

Most mail servers will flag emails that are not secured and may block the email from reaching its 

destination. 

 

Email Address - The end-user will need to add an email address that will send the notification from 

the “host” mail server. (Example: If the user created an email named dms6@gmail.com. The 

notifications would show dms6@gmail.com as the sender. This can be used as an identifier that the 

notification(s) are coming from their DMS software.) 

 

Password – Enter the password here for the email address that will be sending the notifications. 

 
Edit Notifications: Contacts Tab 

 

The Contacts tab in the Edit Notifications window is 
used to manage the contact information needed for 
notifications to be received by individuals. From here, 
the user can review the existing list of contacts and 
edit or remove them as needed. To edit an existing 
contact double left-click their information in the 
contact list. Use the Remove option when the contact 
is selected / highlighted in the list to delete their 
information.  

 

To create a new contact, press the Add button on the Contacts tab to open the New Contact window 

and enter the requested information. 

 

Creating a New Contact 

 

First/Last Name - The contact that will be 
receiving the notifications. 

 
Email - The contact’s address the notification 
will be sent to. 

 
Language - Select the language that will be used 
for the notifications. 

 

 

mailto:dms6@gmail.com
mailto:dms6@gmail.com
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Cell Phone Carrier - The carrier for the contact’s cell phone that will be receiving notifications via 

text. (This option is primarily for North America) 

 

Cell Phone Number - The contact’s cell phone number that they will use to receive the text 

notifications. 

 

Edit Carriers - If the contact’s carrier is not listed as a Cell Phone Carrier selection, they can add 

their carrier here if they know their MMS (Multimedia Messaging). This information can often be 

found through the computer’s web browser. 

 

Edit Notifications: Notifications Tab 

 

 

The Notifications tab in the Edit Notifications window 
is used to create and manage the specific parameters 
that will determine when a notification is sent and the 
contact to which they are sent. From here, the user can 
also review the existing list of notifications and edit or 
remove them as needed. To edit an existing 
notification, double left-click their information in the 
notification list. Use the Remove option when the 
notification is selected / highlighted in the list to 
delete it. 

 

To create a new notification, press the Add button on 
the Notifications tab to open the New Notification 
window and enter the requested information. 

 
 

Creating a New Notification 

 

Monitored Plants – From here, the user can select the DMS Plant that the notification criteria will be 

applied to. 

 

Alarms – The type of alarm that will be shown in the notification. The user can choose between 

None, All Alarms, High Alarms, or All Records. 

 

Limit Period - How often the selected contact will receive the notifications by Minutes, Hours, 

Daily, Weekly, or Monthly. 
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Limit – The number of times within the Limit Period that the contact will receive notifications. 

 

Notification Type – This determines what method of communication is used to send the notification 

to the contact from DMS 6. The available options are by Text, Email, or Webhooks. Note: Only the 

Email Notification Type includes Notification Data options for Wav File, Baseline Wav File, and 

Chart.  

 

Contact – This is used to assign a contact based upon those listed in the “Contacts” tab, to the 

notification being created. 

 

Notification Data – This determines the data from the DMS database that will be included in the 

notification. 

 

Additional Considerations: Webhooks 

 

When an event occurs, DMS as the server-side application will send a POST request to the URL, or 

webhook, with the specified content. The content can be generated based on webhook tokens that are 

available from the Help button of the “Custom Content” tab when creating a new notification. DMS, 

as the server-side application receiving the webhook from the client-side application, can define the 

structure and format of the information shared. 

 

Webhooks are used by numerous client-side applications to send notifications. These applications can 

come in many forms such as websites, programs, and even apps: i.e., Microsoft Teams. The user will 

need to create a webhook either on another website or program so that an individual or a team of 

people would be able to receive the same notification at the same time. 

 

To activate this notification, the user will need to select the Webhook Notification Type. 

 

When the Webhook Notification Type is selected, the New 
Notification window will change to include two Webhook 
Customization Tabs: HTTP Destination and Content.  
 

 
 

HTTP Destination Tab 

 

This tab is used to establish communication from the DMS database to external applications and 

programs. The fields included on this tab can be seen in the previous figure. 
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URI/URL (Web Address) - Once the webhook has been created on the client-side application by the 

user, they would then enter the URI/URL into the URI field of the New Notification window for their 

team to receive the alarms.  

 

Content Type – This is the type of file that it used; JSON file is typically. 

 

Content Tab 

 

When the Content tab is selected, there will be two additional tabs available to allow the user to 

configure Custom and Auto Content. 

 

Custom Content – The user can use this option to customize what is shown in the webhook 

notification. 

 

Auto Content – This option will allow the user to select the Notification Data that will be included in 

the webhook notification when the notification criteria are met. 

 

Webhook Example: Using Microsoft Teams 

 

1) Create a channel through Microsoft Teams 

2) Add members that will receive the notifications within channel 

3) Click the 3 dots within the channel and select “Connectors” 

4) Select “Configure” for Incoming Webhooks 

5) Create name for the incoming webhooks then select create button 

6) Copy the newly created URL and then select done button 

7) Open DMS, click “Notifications” 

8) Click add button for notifications tab 

9) Select the Plant that will be monitored 

10) Click the Webhooks from dropdown from notification type 

11) Select the type of alarm, limit, and limit period 

12) From the HTTP Destination tab, create name of the webhook 

13) Paste the URL within the URI 

14) Select the “Content” tab, then “Auto Content” checkmark the information that will be coming 

through the Microsoft Teams channel. 

15) Select ok when finished  

 

17. Help Menu 
 

This menu is where the user can manually check for 
updates and find UE Systems contact info. 

 
 

Check for Updates 
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If the DMS 6 program has access to the internet, the user can prompt the program to check the UE 

System’s website for a newer version. If there is an updated version, the user will be given the option 

to download that version from the website. 

 

About Ultratrend DMS 

 

When this option is selected from the Help menu, a window will appear showing information about 

the current version of the DMS 6 software installed. The contact information for UE Systems Inc. can 

also be found in this window including a link to the UE Systems website. 

 

III. Database Management 
 

18. Understanding the Database Hierarchy 
 

Most functions for viewing and managing a DMS 
Database can be found in the hierarchy window on the left 
side of the DMS program. This is where the database 
hierarchy will populate when a DMS Plant is created or 
opened. 

 
 

Plant 

 

The Plant is the highest level of the DMS hierarchy and the foundation of the database. A user can 

create and view an unlimited number of Plants. All essential data is contained within the Plant 

including the: Application, Group, Location/Machine, Test Point (the numbered location), and 

Historical Records. To view any of these components, the Plant must be opened. A Plant can have an 

unlimited number of Groups included in its hierarchy. 

 

Application 

 

The Application determines the type of information to be uploaded and downloaded from the 

Ultraprobe. Each Application has its own unique record structure. A Plant can only contain the 

following six Applications:  

  

 Bearings 

 Electrical 

 Generic 

 Leak 

 Steam 



Ultratrend DMS 6 User Manual 

Version 6.8 

 

 

 pg. 39 

 

 Valves 

 

An Application can contain an unlimited number of Groups (this is a general area that includes the 

subject test equipment, it is also known as a “Route”). An Application can be selected when a Plant is 

opened. When creating a new Plant, all six Applications will also be created in the DMS hierarchy. 

 

Group 

 

Creating a list of testing locations and organizing them into a route is identified as a Group in the 

DMS hierarchy. A Group must be assigned to one of the six Applications. The information collected 

in the Group will be placed in fields that relate solely to that specific Application. An unlimited 

amount of historical information can be held in a Group. 

 

The Group is also what defines the records that are sent to the Ultraprobe. It can include a sequential 

set of records ranging from 1 to 400. These records reflect the information found in the 400 memory 

locations of the Ultraprobe. Only one Group can be sent to an Ultraprobe at a time. 

 

Location / Machine 

 

Often considered the primary asset or piece of equipment to be tested, the Location / Machine can 

include one or more specific places identified for testing known as Points. A Location is assigned to a 

Group, which determines the number of characters it can have in its name when it’s created: 8 or 13.  

 

Point / Record 

 

This is the specific Point where the test measurement is taken. It will contain all the Historical 

Records listed chronologically by date of entry. The Point / Record may be created using 8 or 3 

characters depending upon what is selected in the Descriptor Format during Group creation. The 

Points will be listed sequentially in the Group. Therefore, the first Point will be automatically 

assigned 001, up to a maximum 400.  

 

When data is entered into the Point / Record, a Historical Record will be created. After it is created, 

either by downloading data from the Ultraprobe or from being manually entered, the Historical 

Record will be listed under each Point as the date and time of when it was collected. 

 

Historical Record 

 

The Historical Record can be found at the lowest level of the DMS hierarchy. Each time an inspection 

is performed, a Historical Record is created with the data that was collected based upon the 

Application. The Historical Record will include the date and time of the inspection and will populate 

under the specific testing Point from where the data was taken. Multiple Historical Records can 

accumulate over time and will be seen in chronological order under the Point in the DMS hierarchy it 

is assigned. The user may have an unlimited number of Historical Records for each Point.  
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An icon will be displayed next to any Historical Records in the DMS hierarchy that have images or 

sound files attached to them. Different icons are used based upon what is attached as shown in the 

examples below: 

 

Image Attached Icon 

 

When an image has been attached to a Historical Record, an 
icon will be displayed to the left of it. 

 

WAV File Attached Icon 

 

When a WAV file has been attached to a Historical Record, an 
icon will be displayed to the left of it. 

 

Image and WAV File Attached 

Icon 

 

When an image and WAV file have been attached to a 
Historical Record, both icons will be displayed to the left it. 

 

Baseline Record 

 

The first entry of a Historical Record is defaulted by the program as the Baseline Record. A Baseline 

Record can be identified in the DMS hierarchy by the bold text it is shown in. This may be changed 

by identifying another Historical Record assigned to the same Point as the Baseline Record. Enter a 

check in the Baseline checkbox from the “Record Information” tab, and the Baseline Record will 

change to the one selected. It is the baseline record that is uploaded to an Ultraprobe. The baseline 

information is used to compare with new test data as it is being collected and to establish alarm levels.  

 

19. Building a Database 
 

Within DMS 6, there are numerous tools and options for customizing a database hierarchy and most 

of them can be accessed from the hierarchy window. The ability to create, rename, delete, move, and 

restore hierarchy items in the DMS database can all be found in this section.  

 

Accessing a Plant from the Hierarchy 

 

The first step to creating a database starts at the Plant level. An existing Plant can be opened, and a 
new Plant can be created not only from the “File Menu”, but also from the hierarchy window itself. 
Right clicking an empty area in the hierarchy window will open a menu providing these options. 

 

Enable Write Access 

 

 

When a Plant is opened from the “Open Plant” screen it will initially be in 
“View Only”. To perform any activities in DMS that would create, delete, or 
modify 

data, “Enable Write Access” will need to be selected by right clicking the Plant name. To the left of 
each Plant name in the hierarchy window will be an icon identifying if write access is enabled or 
not. 
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New Group by Wizard 

 

To create a “New Group by Wizard”, perform the following steps: 
1) Open an existing Plant. 
2) Right-click the Application to open the hierarchy menu. 
3) Select “New Group by Wizard” from the menu. 
4) Enter the Group Name in the “Group Wizard”. 
5) Select the Descriptor Format from the dropdown. 
6) Enter new Locations and corresponding Points. 
7) Press the OK button when finished. 

 
 

Multiple Locations and Points can be entered using copy/paste functionality by right clicking and 

selecting the option from the menu or by using the standard copy/paste shortcuts CTRL+C/CTRL+V. 

 

Note: The New Location field can be left blank if the Point being created correlates to the last 

Location entered. 

 

Adding Hierarchy Items (Manually) 

 

The user can manually add new Groups, Locations, Points, and Historical Records individually to the 

DMS hierarchy.  

 

New Group 

 

To manually add a new Group, perform the following steps: 
 

1) Right-click the Application name where it will reside. 
2) Select “New Group” from the menu. 
3) Enter the new Group name in the field provided. 
4) Choose the Descriptor Format; this determines the number 

of characters in the Location / Point name. 
5) Press OK to create the new Group. 

 

 

New Location 

 

To manually add a new Location, perform the following steps: 
 

1) Right-click the Group name where it will reside. 
2) Select “New Location” from the menu. 
3) Enter the new Location name in the field provided. 
4) Press OK to create the new Location. 

 

 

New Point 
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To manually add a new Point, perform the following steps: 
 

1) Right-click the Location name where it will reside. 
2) Select “New Point” from the menu. 
3) Enter the new Point name in the field provided. 
4) Press OK to create the new Point. 

 

 

New Historical Record 

 

To manually add a new Historical Record, right-click the Point name where it will reside. Select 
“New Historical Record” from the menu. A new record will be created with the current date & time 
stamp. The user will need to enter any specific data they want associated with that Historical 
Record from the “Record Information” tab. 

 

Removing Hierarchy Items (Permanently) 

 

The user can permanently remove a hierarchy item from 
the DMS database by right clicking the item and 
selecting “Permanently Delete” from the menu. 

 
 
All Historical Records and any other hierarchy levels included under that item will be removed. 
The user will receive confirmation completing the process once accepted. 
 

Note: Be aware that any hierarchy item permanently deleted will NOT be recoverable by the 

Restore function. 

 

Removing Hierarchy Items (Temporarily) 

 

The user can temporarily remove a hierarchy item from the DMS 
database by right clicking the item and selecting “Delete” from the 
menu. All Historical Records and any other hierarchy levels 
included under that item will be removed. The user will receive 
confirmation completing the process once accepted.  

 
This is also known as a “Soft Delete” and any items removed in this 
manner can be restored to the active hierarchy from the Trash bin 
by the user if needed. 

 

 

Managing the Database Trash 

 

The DMS 6 database utilizes an inactive area of the database known 
as “Trash” to allow the user to manage hierarchy items that have 
been temporarily deleted or “Soft Deleted”. By utilizing the “Trash” 
area of the database, hierarchy items can be both returned to active 
database with Restore or permanently deleted with “Empty Trash”. 
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Show Trash - To view temporarily deleted hierarchy items, the 
user can right-click an area in the DMS hierarchy and then select 
“Show Trash” from the menu. This will allow all levels under 
that item that have been deleted to be shown in grey or subdued 
text. A check mark next to “Show Trash” in the hierarchy menu 
will identify it is turned on. 

 
Empty Trash - To permanently delete all hierarchy items in the 
“Trash”; the user can right-click an area in the DMS hierarchy 
and then select “Empty Trash”. This will remove all hierarchy 
items that were previously deleted under the item that was 
selected. 

 

Restoring Hierarchy Items 

 

This function can be used to return any hierarchy items that were temporarily removed or “Soft 
Deleted” to the active database. The user has two options for restoring a hierarchy item, which can be 
accessed through the hierarchy menu. When the user right-clicks an item in the DMS hierarchy, they 
can choose one of the below options to perform the restore. 
 
Restore Deleted Items – This option will restore all hierarchy items located under the item selected. 

 
Restore This Item – This option will restore the specific item selected. 

 

Renaming Hierarchy Items 

 

The user can rename anything within the DMS hierarchy by right clicking the hierarchy item and 
selecting “Rename” from the menu. Once the changes have been made, press “enter” to apply. 

 

Copy & Paste Hierarchy Items 

 

This function can be used to copy a hierarchy item and paste it into another hierarchy with the 
following exceptions: 
 
 The Group Descriptor Format must match. 
 It must not create a duplicate. 
 The Application must match. 

 

To use the Copy function, right-click the hierarchy item and select “Copy” from the menu. To use the 

Paste function, right-click the hierarchy item where it is to go and select “Paste” from the menu. 

 

Note: Be aware that the data that is being copied will copy all data below that entity to the new 

location. 

 

Moving Hierarchy Items 
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Users will be able to rearrange their databases by dragging and dropping hierarchy items. They can 

move their Locations and Points within an existing Group or move them to a different one entirely. 

They can also move an entire Group from one Plant to another by dropping it onto an Application. 

 

 

To move an item in the hierarchy, left click and hold to drag it. Next, drop it to either 
an area in the current Group or into another one with the following exceptions: 
 

 The Group Descriptor Format must match. 
 It must not create a duplicate. 
 The Application must match. 

Note: The symbol to the left will be shown if the attempted drag & drop would be an 

illegal move; except if it would create a duplicate in which case the move would still 

not be accepted. 

  

When moving a hierarchy item within the same level of the hierarchy, it will be placed after the 

hierarchy item it is dropped on. When moving a hierarchy item to a higher level of the hierarchy, it 

will be placed within the hierarchy item it was dropped on. In both instances, the user will receive 

confirmation to complete the move. 

 

  
 

Note: Any Historical Records attached to the hierarchy item will be moved with it. 

 

20. Navigating the Database 
 

Closing a Plant 

 

The user can close any Plants they have open in the hierarchy window by right-clicking them 
individually and selecting “Close Plant” from the menu. 

 

Expand & Collapse Hierarchy 

 

To make the DMS database more manageable, users can quickly navigate the hierarchy by 
expanding and collapsing specific areas. This can be done by right-clicking over the hierarchy level 
to be expanded or collapsed. Select “Expand All” or “Collapse All” from the menu. Everything 
under the hierarchy level selected will expand or collapse accordingly. This function can be 
performed at any level of the DMS hierarchy. 

 

Points Currently In (Alarm) 
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Test Points within a Group that are in an alarm state will be placed 
in a separate area of the DMS hierarchy called “Points Currently 
In” and identified with a bell icon displayed next to it. Click on the 
(+) to open and view any test Points within the Group that have 
been identified as either in High or Low alarm status. 
 

 

The “Points Currently In” area can be moved to the bottom of hierarchy or removed from it entirely. 

This is performed by right-clicking on the appropriate group and selecting “Display Alarms on 

Bottom” or “Hide Alarm Locations” from the menu. If the alarm locations are hidden, the Group 

name in the hierarchy will have an asterisk next to it. 

 

Display Length Settings 

 

If the user has a large collection of Historical Records for a given test Point, they can use this function 

to adjust how many records will be displayed. This is done by the user applying a customizable filter 

based upon the number of months they would like to see data from, starting with the most recent. 

When the filter is turned on, the database will update the test Point by hiding the older data. The 

records that are no longer displayed are only “hidden” from the DMS hierarchy, NOT deleted, and 

can be “unhidden” by turning the filter off. 

 

The Display Length Settings can only be accessed at the test Point 
level by right-clicking it to open the hierarchy menu. A checkmark 
next to “Display Only Last # Months” indicates the filter is applied. 
The Display Length function is separated into two parts: 

 

 

Set Display Length – This is used to set the specific number of months included in the filter. 

Display Only Last # Months – This is used to toggle the filter on and off: the default is 6 months. 

 

 

When “Set Display Length” is selected, a new window will open 
for the user to enter the number of months to be displayed. The 
“Display Only Last # Months” will be updated with the number 
that was entered. 

 

Apply the new filter by selecting “Display Only Last # Months” from the hierarchy menu. A 

checkmark will appear next to it as well as an asterisk next to the Point name to identify that the filter 

is applied. 

 

Note: This function is test Point specific. If the user wants to do this as a global Group function, they 

will need to use the “Group Cleanup” option.  

 

Save a Copy of Plant 

 

This function can be used to save a copy of an individual Plant that is open in the DMS hierarchy. 

The copy will contain all the data found in the original plant, including the images and sound files. 
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To save a copy of an open Plant, perform the following steps: 
 

1) Right-click the Plant from the hierarchy window. 
2) Select “Save Copy of Plant” from the menu. 
3) Choose the location where the copy will be saved and press OK. 
4) The user will receive a “Plant successfully copied!” prompt when the 

process is completed. 

 

 

The folder name for the saved copy will include the original Plant name and the date/time stamp of 

when it was saved. The copy can be imported into another DMS 6 database or kept as a backup for 

the current one if needed. 

 

21. Transferring Data 
 

The “Send Group” and “Retrieve Group” functions can be used to transfer data between the DMS 
database and the Ultraprobe in single group mode. Before any data can be transferred, the user 
must have a Group created in the DMS hierarchy. If there are no Locations or Points within the 
Group when data is downloaded, the DMS software will provide the new Historical Records with 
default names. Only one Group can be loaded to an Ultraprobe at a time for data collection.  
 
Note: Before data can be transferred the corresponding configuration for the Ultraprobe to be 

used must be created and/or selected by using the “Configure Probe” menu option below 

Communications.  

 

Send Group to Probe 

 

 

To upload a Group to an Ultraprobe 401, 9000, 10,000, 15,000 
or 15,000B using “Single Group Mode”; perform the following 
steps: 
 

1) Ensure the Ultraprobe is connected or the SD card to be 
used is inserted. 

2) Right-click the Group from the DMS hierarchy. 
3) Select “Send Group to Probe” from the menu. 
4) The user will receive confirmation when the upload is 

complete. 
 

Note: It is recommended to delete all files and folders from the SD card before uploading a new 

Group to Ultraprobe. Clear Instrument from the “Communications” menu should be performed by 

the user before collecting any new data with the Ultraprobe 3000 or 9000 only. 

 

Retrieve Group from Probe 

 



Ultratrend DMS 6 User Manual 

Version 6.8 

 

 

 pg. 47 

 

 

To download a Group from the Ultraprobe 401, 3000, 9000, 10,000, or 
15,000 using “Single Group Mode”; perform the following steps: 
 

1) Ensure the Ultraprobe is connected or the SD card to be used is 
inserted. 

2) Right-click the Group from the DMS hierarchy. 
3) Select “Retrieve Group from Probe” from the menu. 
4) The user will receive confirmation when the download is complete. 

 

22. Record Cleanup 
 

This function allows the user to “Soft Delete” any unwanted 
Historical Records in the DMS hierarchy based upon the 
selected filter. There are several filter options to choose from 
and when selected it will be applied to all Records under the 
Plant, Group, Location, or Point selected. The items that were 
“Soft Deleted” can still be viewed by choosing Show Trash 
from the hierarchy menu. 
 

 

To utilize the Record Cleanup function, perform the following steps: 

 

1) Right-click on the Plant, Group, Location, or Point where the cleanup is to be performed. 

2) Highlight/Select Record Cleanup from the hierarchy menu. 

3) To the right of the Record Cleanup option a new menu of filter options will be displayed; 

choose the filter to be used. 

4) A new window for the filter chosen will open; enter the specific identifier that will be used for 

filtering. 

5) Select OK when complete to apply the filter. 

 

Note: The user will be able to return the Historical Records that were “Soft Deleted” back into the 

database by right-clicking Plant, Group, Location, or Point they are assigned to and then selecting 

Restore Deleted Items. They can also be permanently deleted the same way by selecting Empty Trash. 

 

Records Older Than 

 

DMS will delete the Historical Records that are older than the date the user chose to filter by. 

 

Records Older Than Baseline 

 

DMS will delete the Historical Records that are older than the current Baseline Record. 

 

Record dB Greater Than 

 

DMS will hide the Historical Records that are greater than the decibel the user chose to filter by. 
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Record dB Less Than 

 

DMS will delete the Historical Records that are less than the decibel the user chose to filter by. 

 

Record Frequency Not Equal To 

 

DMS will delete the Historical Records that do not match the frequency the user chose to filter by. 

 

Point Name Contains 

 

DMS will delete the Points based upon the name or partial name the user chose to filter by. 

 

Location Name Contains 

 

DMS will delete the Locations based upon the name or partial name the user chose to filter by. 

 

23. Synchronize Grease Fields 
 

This option can be performed from the Group level of the DMS hierarchy. It organizes all the Baseline 
information for the lubrication related fields: Planned Strokes, Grease Type, Mass per Stroke, Grease 
Viscosity, Cost Per Mass, and Grease Gun Cal. Date. 

 

Once established, the Baseline information for these fields will be readily viewable in the Historical 

Records of all current and future test Points for a specific Group.  

 

To “Synchronize Grease Fields”, perform the following steps: 

 

1) Establish readings for the following fields in the Baseline of each Point: Planned Strokes, 

Grease Type, Mass per Stroke, Grease Viscosity, Cost Per Mass, Grease Gun Cal. Date. 

2) Right-click the Group name. 

3) Select “Synchronize Grease Fields” from the hierarchy menu. 

4) DMS will then update all Historical Records for all Points within that Group. 

 

24. Configure Lists 
 

 

These lists contain information related to describing details 
of a test for an Application. They can be uploaded to the 
Ultraprobe 10,000 and 15,000 to be used when entering test 
data in the field and can also be used as short-hand 
descriptions when entered into a Historical Record after a 
route has been downloaded to DMS. The list descriptions are 
preset in the software but can be changed or “configured”. 
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These lists contain information related to describing details of a test for an Application. They can be 

uploaded to Ultraprobe 10,000 and 15,000/15,000B to be used when entering test data in the field and 

can also be used as short-hand descriptions when entered into a Historical Record after a route has 

been downloaded to DMS. The list descriptions are preset in the software but can be changed or 

configured. 

 

To configure lists, perform the following steps: 

 

1) Right-click the Plant in the DMS hierarchy and select “Configure lists”. 

2) Choose an Application Type from the drop-down menu provided. 

3) Select the appropriate List Items to edit; this directly correlates with specific data fields found 

on the “Record Information” tab and available based upon the Application chosen. 

4) The List Items area of the window will display items with (3) letters or less such as “NE” for no 

entry or “LUB” for lubricate. 

5) Highlight the List Items to edit and make the needed changes by selecting up to 3 letters; add 

new items by selecting an empty line in the list and doing the same. 

6) To return to the original list as it came from the factory, press the “Revert to Default” button. 

7) Select OK when finished. 

 

25. Update Baselines 
 
This function allows new Baseline Records to be set for all 
Points in the selected Plant, Group, or Location.  
 

 

 

To utilize the “Update Baselines” function, perform the following steps: 

 

1) Right-click on the Plant, Group, or Location where the Baseline Records are to be updated. 

2) Select “Update Baselines” from the menu options. 

3) Choose the option that will be used to determine the new Baseline Records. 

 

26. Bulk Renaming Tool 
 

 
Changes to existing hierarchy names in DMS can be 
performed in bulk for an entire Plant using this tool.  
 

 
 

To utilize the “Bulk Renaming Tool”, perform the following steps: 
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1) Right-click on the Plant containing the hierarchy items to be renamed. 

2) Select “Bulk Renaming Tool” from the menu options. 

3) In the Bulk Renaming screen click on the cell with the hierarchy item that is to be changed. 

(Blank fields are associated with the last hierarchy item listed) 

4) To change the change the Descriptor Format, click on the cell to be changed and select the 

other Descriptor Format available from the drop-down list. (If this causes any character limits 

to be exceeded, as displayed with a red “!”, then they will need to be corrected in the tool 

before the changes can be saved) 

5) To make changes to Equipment Info and Code fields for Locations and Points, the box next to 

Show Equipment Columns must be checked first. 

6) When completed press the “OK” button to accept the changes.  

 

 

IV. Reviewing the Data 
 

27. Record Information Tab 

 

This tab contains the test information for data collected and 
downloaded from any Ultraprobe 401, 3000, 9000, 10,000, 
or 15,000 instruments. Most of the data fields can also be 
populated manually to allow for any potential editing that 
may be needed. Each table of information is linked to a 
specific Historical Record and therefore cannot be opened 
until that Historical Record located in the hierarchy has been 
selected. 

 
 

The left side of the Record Information is for General Information that is included with all ultrasound 

applications. The right side is for any Application Specific Information; the applications include 

Bearing, Electrical, Generic, Leak, Steam, and Valve. 

 

General Information 

 

The following information can be populated for all applications: 

Date/Time – The date and time of data collection. 

dB – Unit of measure for the intensity of sound. 

Frequency – The frequency setting at time of collection. 

Mode - The test mode used in the Ultraprobe: Real Time, Peak Hold, or Snapshot. 

Sensitivity – The level of sensitivity selected at time of collection. 

Offset – The dB minimum reference level set by the user at the time of collection. 

Alarm – This can be set to a specific dB level to identify an unacceptable condition. 

Location/Machine – The equipment identifier for the data collected. 
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Point – The specific point where data is collected. 

Comments - Enter relevant comments in the box. 

WAV File - If a sound is attached to the record, it can be viewed using the open button. 

Record Path - To show where the record resides. 

Module Type - The module used at time of inspection. The user can choose: SCM (Scanning 

Module), STM (Stethoscope Module), UWC (The Parabolic Dish) CFM (Close Focus Module), LRM 

(Long Range Module), FLEX (Flexible probes), RAS MT (Magnetic mount probe), RAS RAM 

(Remote Access Sensor/Remote Access Module) or OTH (Other). 

Inspector ID – The alphanumeric designator used to identify the inspector that collected the data. 

Meter Response - How the intensity & dB indicators move: Fast, Medium, or Slow. 

Units - Standard or Metric. 

Scale - Relative or Offset (refer to the Ultraprobe user’s manual for details). 

Instrument - Enter the Ultraprobe used for this test. 

Serial Number - enter the serial number of the instrument used for this test. 

Baseline – Identifies this specific Historical Record as the baseline reading; this is also used for the 

high and low alarm delta. 

 

Application Specific Information 

 

The following information can only be populated for each specific application: 

 

Bearing Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu). 

Temperature – A field for entering the location temperature at time of collection. 

Info – Available field for additional information. 

Type – Customizable list for entering type (This list can be customized from “Configure Lists” in the 

File menu). 

RPM – The operating speed of the location. 

Bearing Info – Specific information about the bearing such us part number. 

Actual Strokes – The actual number of grease strokes applied. 

Planned Strokes – Total number of grease strokes that is planned. 

Mass Per Stroke – Total amount of grease that comes out of grease gun on one stroke. 

Cost Per Mass – Cost of grease per mass (i.e., grams). 

Grease Gun Cal. Date - When grease gun was last measured for its output mass per stroke. 

Injected Mass – Total amount of grease placed into the bearing housing (Actual Strokes x Mass Per 

Stroke). 

Grease Type – Mineral Base, Synthetic & Polyurea. (The user can add other types of grease for this 

field from “Configure Lists” in the File menu). 

Grease Viscosity – Type of viscosity used for that bearing “100, 150, 220, 460”. (The user can add 

more viscosities within the “Configure Lists” in the File menu). 

Injected Cost - Total cost of grease being placed in that bearing (Cost Per Mass x Injected Mass). 
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Electrical Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu). 

Temperature – A field for entering the location temperature at time of collection. 

Location – Customizable list for additional location information (This list can be customized from 

“Configure Lists” in the File menu). 

Item Component – Customizable list for entering item component information (This list can be 

customized from “Configure Lists” in the File menu). 

Voltage – Customizable list for entering voltage (This list can be customized from “Configure Lists” 

in the File menu). 

Humidity – Field for entering the location humidity at time of collection. 

 

Generic Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu) 

Temperature – A field for entering the location temperature at time of collection 

 

Leak Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu). 

Pressure – A field for entering the location pressure at time of collection. 

Application – Customizable list for entering application (This list can be customized from 

“Configure Lists” in the File menu). 

Distance – Customizable list for entering distance (This list can be customized from “Configure 

Lists” in the File menu). 

 

Steam Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu). 

Manufacturer – Customizable list for entering manufacturer (This list can be customized from 

“Configure Lists” in the File menu). 

Model – Customizable list for entering model (This list can be customized from “Configure Lists” in 

the File menu). 

Application – Customizable list for entering application (This list can be customized from 

“Configure Lists” in the File menu). 

Op Type – Customizable list for entering trap operating type (This list can be customized from 

“Configure Lists” in the File menu). 

Pipe Size – Customizable list for entering pipe size (This list can be customized from “Configure 

Lists” in the File menu). 
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Orifice Size – Customizable list for entering orifice size (This list can be customized from 

“Configure Lists” in the File menu). 

Inlet Temp. – A field for entering the inlet temperature at time of collection. 

Outlet Temp. – A field for entering the outlet temperature at time of collection. 

 

Valve Application 

 

Test Result – This data varies depending upon the application (The user can customize this list from 

“Configure Lists” in the File menu). 

Temperature – A field for entering the location temperature at time of collection. 

Pressure – A field for entering the location pressure at time of collection. 

Valve Type – Customizable list for entering valve type (This list can be customized from “Configure 

Lists” in the File menu). 

Application – Customizable list for entering application (This list can be customized from 

“Configure Lists” in the File menu). 

Pipe Size – A field for entering pipe size. 

A – The dB level at test point A. 

B - The dB level at test point B. 

C – The dB level at test point C. 

D – The dB level at test point D. 

 

28. Images Tab 
 

This tab can be used to attach images to various levels of the 
Ultratrend DMS database. Images can be added to any of the 
following hierarchy levels: Group, Location/Machine, Point, 
or Historical Record. Select the position in the DMS 
hierarchy and choose the Images tab to view what images 
are currently attached. There are two main functions in the 
Images tab, “Add” and “Remove” 

 
 

Adding an Image 

 

1) Select the position in the database hierarchy where an image is to be added. 

2) Select the Images tab if it has not been previously selected. 

3) Click the “Add” button in the bottom left of the Images Tab screen. 

4) Locate the file path and select OK. 

 

Removing an Image 

 

1) Select the position in the database hierarchy where an image is to be removed. 
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2) Select the Images tab if it has not been previously selected. 

3) Highlight/select the image to be removed. 

4) Click the “Remove” button in the bottom left of the Images Tab screen. 

 

29. History Tab 
 

The History tab allows information from numerous Historical 
Records under a selected test Point in the hierarchy to be 
displayed together in spread sheet form. This information also 
determines what trend lines are created in the “Chart” tab. The 
number of Historical Records shown can be changed by 
entering the number of months to be displayed from the “Chart 
Tab”; please reference “IV. Reviewing the Data: 25.0. Chart 
Tab” section of this manual for additional information.  

  
 

Using the Selector Box 

 

To create the spread sheet in the History tab, perform the following steps: 

 

1) Select the desired test Point in the DMS hierarchy. 

2) Open the History tab if it is not already opened. 

3) Using the Selector Box highlight the desired test information item. 

4) Use the left arrow key to move it to the spread sheet. 

5) Use the right arrow to return any column from the spread sheet to the Selector Box. 

 

30. Chart Tab 
 

The Chart tab displays trend lines based upon the information 
selected in the “History” tab. The Y Axis displays the dB level 
while the X Axis shows the date. The user can customize the 
chart by adjusting the scale for both the X and Y Axis and by 
adding on chart remarks in the form of Annotations. Charts 
can be exported and saved in a variety of ways to allow for 
archiving and viewing later. 

 
 

Note: The Chart function can only be accessed when selecting / highlighting a specific testing Point 

in the DMS hierarchy. 

 

Adjusting the Chart Scale 
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X Axis – This scale can be adjusted by entering the number of months in the “Display Months” box; 

when finished press “Enter” or left-click on another area of the screen to apply. The change to the 

date range shown can be applied to all charts in the Group by pressing the “Apply to Group” button. 

 

Y Axis – This scale can be adjusted by selecting the high and/or low values shown on the left side of 

the chart and entering a new value. The new values will determine the minimum and maximum dB 

values that will be shown in the chart. 

 

Note: Both Axis can be set to “Auto Scale” from The Chart Options Menu (accessed by right clicking 

the Chart plot). 

 

Chart Annotations 

 

Text based Annotations can be created to identify areas of focus on the trend chart. Below are the 

chart options for creating and managing these Annotations: 

 

Create Annotations – Allows the user to create an Annotation to the chart; accessed by right-

clicking the Chart plot to open the Chart Options Menu  

 

Delete All Annotations – Allows the user to delete all Annotations on the chart; accessed by right-

clicking the Chart plot to open the Chart Options Menu. 

 

Edit Annotations (Menu) – When right-clicking an Annotation, a menu will appear to edit the 

attributes such as color, line/pointer style, and line width. The “Snap To” feature can be accessed 

from here to allow an Annotation to be automatically attached to a specific trend marker in the chart. 

This is also where the user can delete a specific annotation if needed. 

 

Saving a Chart 

 

Export – Attaches a copy of the chart to the “Point” in the hierarchy. 

Save – Will save the chart as a JPEG file. 

Print – The user can print the chart as an HTML file in the web browser or save it as a PDF 

document. 

 

31. Alarms Tab 
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This tab can be used to establish dB-based Alarm levels for 
each Point in a Group. The user has the option to set both a 
High- and Low-level Alarm. To use the Alarms tab, a 
Historical Record must be selected in the hierarchy. 
Historical Records that break established Low Alarms will 
be highlighted yellow in the hierarchy and those that break 
High Alarms will be highlighted red. 
 

 
 

When the Alarms tab is open, there are two choices: “Update All Alarm Levels Using Values” or 

“Update All Alarm Levels Using Deltas”. 

 

Setting Alarm Levels 

 

When setting the Alarm levels there are two options: “Update All Alarm Levels Using Values” or 

“Update All Alarm Levels Using Deltas”. When one of these options is selected it will apply those 

Alarm settings to all current and future Historical Records for each Point in that Group hierarchy. 

 

Note: The default Alarm setting is a value of 122 dB for both the High and Low Alarm Level until a 

new Alarm level is entered and established. 

 

Update All Alarm Levels Using Values – To set the Alarm Levels to a defined value, enter those 

values in the High and Low Alarm Level fields, then press the “Update All Alarm Levels Using 

Values” button next to them to apply. 

 

Update All Alarm Levels Using Deltas – This can be used to determine the High and Low Alarm 

Levels as a rise over established Baseline Historical Recordings. Enter the High and Low Alarm 

Delta, then press the “Update All Alarm Levels Using Deltas” button next to them to apply. The new 

Alarm Levels will equal the Alarm Delta value entered plus the Baseline dB of each Point. 

 

 

Alarm State Info 

 

The record information of the specific Historical Record selected will be displayed in the box at the 

bottom of the Alarms tab labeled “Record Information”. This area will also identify if it is a Baseline 

Historical Record and if it is or is not breaking the established Alarms. 

 

32. Reports Tab 
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The Reports tab offers additional capabilities for 
reviewing and data mining the information collected 
and entered the DMS 6 database. This is done by 
providing numerous report templates based upon 
Application type that can be generated for any Group 
in the DMS database hierarchy. 
 

 
 

Creating Reports 

 

To generate a report, perform the following steps:  

 

1) Select the specific Group in the DMS hierarchy that contains the information to be included. 

2) Open the Report tab if it is not already opened. 

3) Choose from the available reports on the Report Template List to the left of the “Generate 

Selected Reports” button. 

4) Press the “Generate Selected Report” button. 

5) Choose a file path where the report will be saved, name the file, and press the OK button to 

complete. 

6) A notification window will inform the user when the report has been saved successfully, locate, 

and open the file to review. 

 

Available Report Templates 

 

There are six distinct types of Applications that can be found in the DMS 6 database hierarchy. Each 

of these Applications determines the type of reports that can be generated from the Reports tab.  

The following is a brief description of each of the Report Templates: 

 

Alarm Report 

 

This report will only show test Points within a highlighted Group in the DMS hierarchy that exceeded 

established alarms during their most recent Historical Recordings. Some of the information included 

in this report is: hierarchy location info, date, sensitivity, frequency, dB Level, and alarm status 

information.  

 

The following applications can generate this report: Bearing / Electrical / Generic / Leak / Steam / 

Valve 

 

Bearing Lube Report 
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This report will only show test Points within a highlighted Group in the DMS hierarchy that exceeded 

established alarms during their most recent Historical Recordings. It includes all the information 

found in the “Alarm Report” with the addition of the type of lube and if it was lubed data fields. 

 

The following applications can generate this report: Bearing  

 

Master Route Report 

 

This report would show all test Points within a highlighted Group in the DMS hierarchy based upon 

their most recent Historical Recordings, no matter if they broke the established alarms or not. Some 

of the information included in this report is: hierarchy location info, alarm status information, and any 

comments that were entered for that record.  

 

The following applications can generate this report: Bearing / Generic 

 

Everything Report 

 

This report will include all data entered in DMS for every Point within a highlighted Group in the 

DMS hierarchy. This includes all Historical Recordings to date and every data field for all 

Applications. 

 

The following applications can generate this report: Bearing / Electrical / Generic / Leak / Steam / 

Valve 

 

Bearing Lube Fields 

 

This report will show the Historical Recordings for all test Points within a highlighted Group in the 

DMS hierarchy based upon the month selected when generating the report. It includes all the 

information found on the “Bearing Lube Report” with the added fields for performing a lubrication 

cost analysis. This report is customizable including only the data fields that were selected by the user 

while creating the report. 

 

The following applications can generate this report: Bearing 

 

Two Pic Report 

 

This report can be used to communicate leak survey findings by generating two individual records per 

page with one image per record. It will select the first image in the Historical Record from each Point 

within DMS to populate in the report. This report also includes data fields that can be manually 

entered by the end-user to track repair completion for the leaks identified during the survey: fields 

such as Leak Repaired status, Date, and Initials. 

 

The following applications can generate this report: Leak 
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Four Pic Report 

 

This report can be used to communicate defects based upon ultrasound findings that can include up to 

four images and sound files for a test Point within a highlighted Group in the DMS hierarchy. The 

user can choose which sound files and images to include in the report from a Historical Record by 

selecting that location from the report menu hierarchy on the left and then using the drop-down 

menus under the ones that are shown as available options. This report also includes data fields that 

can be manually entered by the end-user to track repair completion for the identified defects: such as 

Suggested Corrective Action, Repair Date, Repairs Performed, and Repaired By. 

 

The following applications can generate this report: Bearing / Electrical 

 

Mixed Compressed Gas Report 

 

This report displays data from a leak survey; it can be used for any gas. The default gas selections in 

the sheet are: Compressed Air, Argon, Helium, Hydrogen, and Other. It will compute the cost of the 

leak and the impact on the plant’s Carbon Footprint. The user may adjust the local carbon gas 

emissions in the coefficient located on the bottom of the Compressed Gas report sheet. 

 

There are tabs on the bottom of the spread sheet which will guide the user to: Cost, Report 

(annualized updated report), Month (Monthly results), Master (this blank sheet is only used to 

facilitate importing of data and does not need to be used), Flow Rate Chart (for setting the CFM 

“Guesstimate”), and a Coefficient Table to select the greenhouse gas results by the state/area where 

the test was performed. It will report on the savings per month and globally update the Report Sheet 

to review the results on an annualized basis. 

 

The following applications can generate this report: Leak 

 

Compressed Air Report 

 

This report is identical to the “Mixed Compressed Gas Report” except it does not include any of the 

specialty gases.  

 

The following applications can generate this report: Leak 

 

Leak Survey Report 

 

Similar to the “Mixed Compressed Gas Report” that also includes a dashboard for better visualization 

of cost savings and the overall performance of your energy conservation program.  

 

The following applications can generate this report: Leak 

 

Steam Report 
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This report details the steam trap survey results and the steam trap condition for the most recent 

Historical Recordings for all the test Points in the Group. It includes all the pertinent data fields for 

determining additional steam costs due to defective conditions identified. This report is customizable, 

including only the data fields that the user selects when creating the report. 

 

The following applications can generate this report: Steam 

 

33. Dashboards Tab 
 

The Dashboards tab can be used to provide an 
overview of the alarming and collection status of 
test Points for multiple Plants and Groups from the 
DMS hierarchy. The pie charts at the bottom of the 
Dashboard provide a visual component to view the 
data that can also be expanded to make it easier to 
read. 
 

 
 

To determine the test Points that will be shown in the Dashboard, 
press the “Edit Filters” button and enter a check in the boxes next to 
the Plants and/or Groups that will be included. When the selections 
have been made, press OK to apply the filter changes to the 
Dashboard. The filters that are currently applied can be seen in the 
top left area of the Dashboard. 

 
The information displayed on the Dashboard is separated into two 
sides, one based upon “High & Low Alarms” and the other on “Days 
Since Last Reading”. below is a detailed description for both:  

 

 

High & Low Alarms 

 

The left side of the Dashboard screen includes information for each test Point that is in an Alarm 

State from the Plants and Groups selected in the filter. The upper portion shows the information for 

the test Points in High Alarm and the one below it shows those that are in Low Alarm. A pie chart can 

be found at the bottom of the Dashboard that visually depicts the overall Alarm State of all test Points 

from the Plants and Groups the user has selected. In the pie chart: Green = No Alarm, Yellow = Low 

Alarm, Red = High Alarm. 

 

Days Since Last Reading 

 

The right side of the Dashboard screen includes information based upon the last day data collected for 

each test Point from the Plants and Groups selected in the filter. It comes in two portions that the user 
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can customize by selecting the number of days next to “Days Since Last Reading”. The choices range 

from 7 to 1,080 with one consideration; the upper portion must have a higher number of days than the 

lower portion. The upper portion will also take precedence over the lower portion during the filtering 

process, ensuring anything included in the upper portion will not be duplicated in the bottom portion. 

A pie chart can be found at the bottom of the Dashboard that visually depicts the overall number of 

days from each portion customized by the user. In the pie chart: Green = Points that were Current (or 

below the number of days selected in the bottom portion), Yellow = Points that exceed the number of 

days in the bottom portion, and Red = Points that exceed the number of days in the top portion. 

 

Export 

 

It can be used to export the Dashboard into a spreadsheet format. It will give the breakdown of 

“high”, “low” alarms along with “Days Since Last Readings” 

 

V. Configuring the 4Cast System 
 

34. Introducing the 4Cast Manager 
 

Once the 4Cast is connected to the computer that will be retrieving the data, the user can configure it 

with the 4Cast Manager by pressing the “UE 4Cast” button in the upper-right corner of the DMS 6 

software. 

 

When the 4Cast Manager opens, a list of 4Casts connected to the 
computer will be seen on the left. A “green circle with a 
checkmark” next to a 4Cast indicates it is connected and 
operating properly. A “red circle with a x” indicates it was once 
connected, but it is currently experiencing connection or 
operation issues. 

 
To perform any modifications in the 4Cast manager, the user 
will need to press the “Start Editing” button in the upper-right 
corner. 

 

 

35. UE 4Cast Configuration Tab 
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The Configuration tab of the 4Cast Manager can be 
used to view specific information unique to each 4Cast 
such as their UUID and IP Address. The user can also 
use the tab to add and remove images, update the 4Cast 
firmware and change how long a 4Cast will archive 
data. 
 

 
 

Data Archiving Settings 

 

Name – The user can enter a specific name for the 4Cast in this field. 

Keep Readings For # Days – This is for the number of days an individual 4Cast will archive the dB 

only readings before it will begin writing over the old data. 

Keep Readings and WAVs For # Days – The is for the number of days an individual 4Cast will 

archive the readings with WAV files before it will begin writing over the old data. 

Set – This button is used to save any changes made to the Data Archiving Settings. 

 

4Cast Info Section 

 

UUID – The Universal Unique ID for the 4Cast. 

IP Address – The address for that specific 4Cast. 

Current Firmware Version – The version of firmware installed on the 4Cast. 

Update Firmware - If there is an update for the 4Cast, this button can be used to update it. 

Reset - This button can be used to reset the individual 4Cast. 

 

Note: Resetting the 4Cast will NOT delete settings that had been previously entered. 

 

Add / Remove Images 

 

Add – The user can link an image to the 4Cast by selecting this button and then choosing the file 

location. 

Remove - To remove a link to an image associated with that 4Cast, highlight that image, and then 

select the “Remove” button. 

 

36. UE 4Casts Points Tab 
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With this tab the user can link the 4Cast to an existing 
DMS database where data will be downloaded and 
stored. This tab also provides the user with multiple 
options to manually request the immediate downloading 
of data from the 4Cast to the DMS database. 

 

 
 

DMS Hierarchy Links 

 

The dropdown fields can be used to map the 4Cast sensors to the DMS hierarchy. For this to work, 

the corresponding hierarchy must already be created in the DMS database. The user can select from 

the Plant to Point level with the dropdown lists based upon the available options from the DMS 

hierarchy. Once the options have been selected, press the “Set All” button to save the changes. 

 

Get Readings & Get Readings with WAVs Now 

 

Get Readings Now – With this button, the user can download an immediate dB only reading from a 

single sensor and send that to the DMS database. This is normally done to establish an initial Baseline 

Record for that Point in the database. Each sensor has this feature and if the user wants to capture dB 

readings for all four sensors, they can select the first button on the far left. The first button is for a 

global retrieval of a dB only reading for all four sensors. 

 

Get Readings with WAVs Now – This is the same as “Get Readings Now”, except the user will also 

receive a WAV file with a dB reading when it is collected. The first button on the left labeled, “Get 

Readings with WAVs Now”, is for a global retrieval of a dB reading with WAV file for all four 

sensors. 

 

 

Archive Access 

 

The user will be able to download dB readings and WAV files from a certain date and time range 

based upon the parameter information entered below. After the parameter information has been 

entered, the user can select either “Get Readings Between Dates” or “Get Readings with WAVs 

Between Dates” to start the download. 

 

Sensor – This is used to identify which 4Cast sensor the data is to be downloaded from. 

Start – The user can enter the Start Date & Time for the data to be downloaded. 

End – The user can enter the End Date & Time for the data to be downloaded. 

MAX – The user can choose the number of Readings / WAV files to be downloaded.  

 

With the given parameters, the 4Cast will then be able to download the data from its internal storage 

and send that information to DMS to be stored. 
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37. Sensor Setup Tab 
 

The Sensor Setup tab can be used to make any necessary 
adjustments to ensure the sensors connected to the 4Cast 
are collecting quality ultrasound readings and sound files. 
If the adjustments are correct, the 4Cast will always 
receive quality data, even if the sensor is in an alarm 
state. 
 

 
 

Live Mode Toggle 

 

This will allow the user to turn on Live Mode when needed to actively view the current dB output of 

each sensor. Each sensor can be toggled in and out of Live Mode individually with a Start / Stop 

button located at the bottom of the “Sensor Setup Tab”. This can be especially useful when setting up 

sensors initially, to ensure the Sensor Settings are properly adjusted. 

 

Sensor Settings 

 

Any Sensor Setting changes can be permanently saved by pressing the “Set” button at the bottom of 

the sensor from where those changes were made. This can also be done for all sensors at one time by 

pressing the “Set All” button to the left of the “Set” button for the individual sensors.  

 

Sensor Signal Level – This is the intensity of the signal going through the sensor. This is important 

when it comes to recording quality sound to analyze through the UE Spectralyzer software. The 

optimum intensity level is typically considered to be around 25%. The user can adjust the intensity 

through the Sensitivity or Auto Sensitivity settings. 

 

Sensor Reading – This is the measure of sound that the sensor is reading shown as a dB value. If the 

user sees (>>) instead of a dB value, it means that the sensor is under-range, and that the sensitivity 

needs to be increased. If the value is (<<), it means that the sensor is over-range, and the sensitivity 

needs to decrease. 

 

Sensor Reading Averaging – This is the number of averages per second that the sensor will take 

when data is collected. This can help smooth out the dB value by averaging out transient events that 

may be causing the data to appear chaotic and difficult to use in some scenarios. The user will be able 

to select the number of averages up to a maximum of 20 samples per second. 

 

Sensor Reading Offset - If the 4Cast is going to be taking readings on an existing route that an 

Ultraprobe was taking readings from in the past, the user can use an offset to adjust for the dB 

difference as needed. This will ensure that the readings stay consistent between both data collection 

methods. 



Ultratrend DMS 6 User Manual 

Version 6.8 

 

 

 pg. 65 

 

 

Alarm State – This provides indication of a sensor that is exceeding the established Alarm Level; 

“red” circle indicates it is in alarm, and a “blue” circle indicates it is not. 

 

Alarm Level - Once the dB is established, the user can set a dB value for the Alarm level on that 

sensor. If the sensor has a dB value higher than the Alarm Level dB, it will trigger the 4Cast to start 

recording the dB value and sound file, so it can be sent to DMS. 

 

Alarm Delay – This setting can be adjusted up to a maximum of 60 seconds and it will start from 

when the sensor hits the established Alarm Level. Once the adjusted time is exceeded, and if the 

sensor is still in alarm, it will trigger the 4Cast to start taking a reading for that sensor. If the dB level 

falls below the Alarm Level after time has exceeded, no reading will be taken to mitigate unwanted 

data being uploaded to the DMS database. 

 

Alarm Release - When a sensor constantly goes in and out of an Alarm State, the Alarm Release can 

be used to establish a lower dB value to determine when that sensor leaves alarm. Enter the dB value 

to be subtracted from the Alarm Level, up to a maximum of 9 dB, to determine what dB value the 

sensor must fall below before it is no longer considered to be in alarm. 

 

Auto Sensitivity – This represents the percentage of scale for the Sensor Signal Level of each sensor. 

By checking or unchecking the box, the user can enable or disable the High and Low Trigger Levels. 

When enabled, this can be used to automatically adjust Sensitivity based upon specific Sensor Signal 

Level positions established by the user. 

 

Auto Sensitivity High/Low Trigger Level - Based upon a percentage scale from (0-100%), the user 

can establish Trigger Levels for the Sensitivity to be automatically adjusted. The 4Cast will 

automatically reduce the Sensitivity until the Sensor Signal Level is within the High & Low Trigger 

Levels.  

 

Sensitivity - Used to adjust the intensity of sound that comes through the sensor. This can manually 

and will help with under and over-ranged conditions. 

 

38. Reading Schedule Tab 
 

The Reading Schedule Tab can be used to configure the 
automatic collection of dB only readings by the 4Cast. It 
can also be used to determine when the data stored in the 
4Cast is sent to the DMS database. There are numerous 
Scheduling Options available to customize the 4Cast’s 
data acquisition process. 
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Apply to All – After a sensor has been configured, press the “Apply to All” button under that sensor 

to copy that configuration to the other sensors. 

 

Scheduling Options 

 

Any Scheduling Options changed can be permanently saved by pressing the “Set” button at the 

bottom of the sensor from where those changes were made. This can also be done for all sensors at 

one time by pressing the “Set All” button to the left of the “Set” button for the individual sensors.  

 

Storage Interval – How often a sensor will take readings and store them internally in the 4Cast. The 

interval can be expressed in minutes, hours, days, or weeks.  

 

Send-to-DMS Intervals – How often data will be sent from the 4Cast to the DMS 6 database. The 

interval can be expressed in minutes, hours, days, or weeks. 

 

Storage Interval When in Alarm – How often a reading will be collected with the 4Cast once a 

sensor goes into alarm. The interval can be expressed in minutes, hours, days, or weeks. 

 

Readings Before\During\After Alarm to send to DMS - The number of readings the 4Cast will 

send to the DMS database when a sensor goes into alarm. 

 

Trigger on dB Level - The dB value that must be exceeded before a scheduled reading will be taken. 

 

Delay Start up – This option works in conjunction with Trigger on dB Level and allows for a time 

delay of up to 60 seconds to be added before a scheduled reading is taken after the trigger is 

exceeded.  

 

39. WAVs Schedule Tab 
 

The WAVs Schedule Tab can be used to configure the 
automatic collection of a WAV file by the 4Cast. It can also 
be used to determine when the data stored in the 4Cast is 
sent to the DMS database. There are numerous Scheduling 
Options available to customize the 4Cast’s data acquisition 
process. 

 
 

 

Apply to All – After a sensor has been configured, press the “Apply to All” button under that sensor 

to copy that configuration to the other sensors. 

 

Scheduling Options 
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Any Scheduling Options changed can be permanently saved by pressing the “Set” button at the 

bottom of the sensor from where those changes were made. This can also be done for all sensors at 

one time by pressing the “Set All” button.  

   

WAV Storage Interval - How often a sensor will take WAV files and store them internally in the 

4Cast. The interval can be expressed in minutes, hours, days, or weeks. 

 

WAV Send-to-DMS Interval - How often WAV files will be sent from the 4Cast to the DMS 6 

database. The interval can be expressed in minutes, hours, days, or weeks. 

 

WAV Storage Interval When in Alarm - How often a WAV file will be collected with the 4Cast 

once a sensor goes into alarm. The interval can be expressed in minutes, hours, days, or weeks. 

 

WAVs Before\During\After Alarm to send to DMS - The number of WAV files the 4Cast will 

send to the DMS database when a sensor goes into alarm. 

 

WAV Record Time (s) Normal\Alarm\Manual - The recording time for WAV files during normal, 

alarm, and manual collections (0-60 seconds). 

 

Note: It is strongly advised not to take sound recordings with the 4Cast at 10 minute or below 

intervals. 
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